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Introduction

The AVANT REMSsp represents a new era of precision in-situ verification for your office. Compact yet
rugged, this PC-Based system is USB powered and supports ANSI and IEC Real Ear tests. The software
includes targets for DSL i/o 5.0 and NAL-NL2. The REMsp is an affordable, single probe device which
utilizes MedRx’s in-situ method for getting the fitting right the first time, every time. The following section
of this manual will familiarize you with the physical features and accessories of the REMsp system.

This manual assumes that the system hardware, software and drivers are installed and working properly.
Please refer to the MedRx AVANT REMsp Installation Manual for assistance.

The scope of this manual is to get you “up and running” with the Avant REMsp System. Please consult
the interactive Help System within the software for more detailed information of features and functionality.
To access this tool, press the F1 key at any time, or click the Help icon or menu item with your mouse.

Measurement uncertainty is +/- 1 dB.

Refer to the Help files for test options and descriptions.

Also refer to the Help files for test signal characteristics, analysis, equalization methods and the effect of
analyzer setting on accuracy.

The AVANT REMsp Software

General Overview

The AVANT REMSsp software will either run as a measurement module within NOAH" (figure 1) or as a
stand-alone module (figure 2), or in the TIMS NOAH-Compatible Office System.

The software includes a context-sensitive interactive Help System. To access this tool, press the F1 key
at any time, or click the Help menu with your mouse. This will display additional information and
instructions for the specific section of the software you are working in.

E
P uncen o

-
&
AVANT -
e = 5
Figure 1 The AVANT REMsp in NOAH Figure 2 The AVANT REMsp
Main Screen Stand Alone
3
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Launching the REMsp Software

Stand Alone

oL

AvantREM-5P

NOAH and TIMS

Module Selection
Fiting  Measurement | Other |
AVANT| |AVANT
medrs e 820 MedRi o REM|
NOAHaud 3 AvantA2D AvantREM
AVANT| |AVANT| |AVANT
MedRx e HIT|  |Memxhe REM# |- MedR,Inc
AvantHIT AvantREM Plus Avart
AVANT
[Medps, Inc. REM-SP)
AvantAUD AvantREM-SP
Licensed to: - MedRx, Inc. - SALES - SALES LICENSE, FOR INTERNAL

Cancel

1. Double click the 1. Launch NOAH.
AVANT REMsp 2.
shortcut on your 3.
Windows Desktop. REMsp icon.

Software Op

Basic Options

tions

25 NOAH - [Session Browser]
?g File Wiew Window Help
iy & & (2
Uy

Click the Real Ear Measurement Toolbar lcon.
Or, from the Module Selection screen, double click the AVANT

Several options are available which allow the user to customize the AVANT REMsp Software to meet

their needs.

Access these options from the File Menu on
the Avant REMsp Main Screen as shown
below.

;  AvantREMsp

== Function Help

Clear Session Data
Print Setup...

Page Setup...
Advanced Opgs. i
Exit

The Options may also be accessed
from within the Avant REMsp main
program by clicking on the Options text
menu as shown below.

File Function Ear Audio Stimulus

AvantREMsp - Live Speech Mapping

|Aw£o

HL

L)
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The software allows you to set several default options as described below.

View | Audio | Live Speech | REM | MHAHLS | Tymp |

Plot Speech Spectum
¥ Vettical Grid ¥ Canoe
' Horizontal Grid % Speech Sounds
Language: Font Size:
Sight
syl [ones =] Defals | 12 ~
size: |50
Defauk Ear: [Right
¥ Hide Plots During Test Flot Curves Width: [Thick
Dual Plat: [T
' Use Plot Antialiasing
[_iRevorsaEars Live Painting Mode:
[ Maintain Plot Ratios Full Canvas -~
oK Cancel | Hep |

The View tab allows you
to set the default
appearance of the
REMSsp test environment.
Values can be changed
by using the check boxes
and pull-down menus
shown above.

Options &

Wiew I Live Speech} REM  MHAHLS hymp I

HLS

Default HLS Level 4:
HLS Sirmulation: ’m

Use Live Speech Mapping: W inSPL [ inHL

MH&

Default MHA Level [0 =
MHA Simulaton: [Nomal ]

Use Live Speech Mapping v

View | Audio  Live Speech | REM | MHAHLS | Tymp |

Default Stimulus: [Microphone |
Defauit Level: [65 =]
Smooth O/E: [ +]

Live Speech
¥ Show Fall Sounds
I~ Show Peak Sounds

LTAS
Thieshold (dB): |50 =

Roling Window (sec): {30 ‘%‘
Smooth: Y

Analyzer
Octave Bands: [1/3 v

¥ Interpolate Curves

Show Targets:

<None> v IV Save Together With LSM
Speakers:

1 ehonHEL <Not Available> v

I~ Show Average UCL

o]

Cancel | Hep

Options

View | Audio | Live Speech REM \MHA/HLS] Tymp |

Default Stimulus:

DefaulLevel: [55 =
Analyzer

Octave Bands: [172 =]

¥ Interpolate Curves

Show Targets:

Average Readings: [§  ~
Smooth Plats: -

Sample Averaging Time (seck: [0 =

ICRA Averaging Time (sec: [15 =

&

<None> 54 _I
¥ ShowKEMAR et [70 <] 8 Speskers
I Show SPL Reference Curve SEET LT |
I Show REUR on REAR
oK Cancel | Hep |

The Live Speech tab sets
the look and behavior of the
Live Speech Mapping
function. Use the Show
Targets pull-down to
underlay DSL 5.0 or NAL-
NL1 & NL2 targets below
your speech maps.

Options. &

View | Live Speech | REM | MHAHLS Tymp |

¥ Show The Norm Area Scaling: |Aute -
¥ Auto Switch Modes

W Interpolate Curve

o]

Cancel ‘ Help

o

Cancel Help

The MHA/ HLS tab sets
the default look and
behavior of the Master
Hearing Aid and Hearing
Loss Simulator.

If your system has a
Tympanometer connected,
this tab will assist in
configuring the look of the
display.

The REM tab sets the
default look and behavior
of conventional Real Ear
Measurements.

NOTE: Remember, that more information is always available in the Interactive Help System by clicking
the Help Icon or pressing the F1 key.
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Advanced Options

The Advanced Options screen allows you to

configure your system to meet your individual BT Function  Help
clinical needs. It also provides MedRx Clear Session Data
Technical Support with tools for helping you Print Setup...
troubleshoot problems. Access this screen _PageSetup...
from the File Menu on the Avant Main Screen Optiars. .

as shown to the right.
Exit

The key features of each tab are described below. For more in-depth information, consult the
interactive Help system within the software.

Advanced Options @ Advanced Options @

General IAudiu | Video | Tympanometry | General Audio IViden | Tympanometry |
I Boost Priority During Measurements CD-ROM Drive: |D: v [T M e dRx REM-SP Audio
™" Multiple Monitors Input Device: [MedRx REM-SP Audio ~l
v Do Not Disconnect from NOAH when Fitting
Output Miver: [MedRx REM-SP Audio ~|
M} Input Miker: [MedRs REM-SP Audio ~|
Input Line: [ <Defaut Line> =l
Syslemlniuvmatiunl Device Manager | Language |
Audio Properties
0K | cocel | Hep | 0K | Cancel | Hep |
The General Tab configures the overall Avant  Use the Audio Tab to select the proper audio
REMsp behavior with respect to other device for your Avant REMsp. This tab also
Windows programs, specifically NOAH. provides access to the Windows Audio
controls.
If your system has a Video Otoscope, the
General| Audo Video | Tympanomely | Video Tab allows you to select the
Otoscope Input appropriate input device.
BIVCH N ot Available b

I | |

Alternative Input

Device: |Not Available LI

0K I Cancel Help
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Advanced Options 3] If your system has a Tympanometer

General | Audio | Video  Tympanomety | connected, use this tab to configure the
equipment according to the manufacturer’s
instructions.

LE EE N Dtowave Model 102

oK I Cancel Help

Preparing for Testing

Connecting the Speaker

v

The speaker may be battery powered or plugged
into the plug-in power supply that is included. Connect the speaker to the AVANT REMsp main
unit as shown above.
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The Speaker is placed at a distance of about 1 meter from the patient, for normal use. The front view of
the speaker is shown below, with both the charging cable attached. The Bluetooth option is not used. The
speaker’s power cable is a USB “male A to micro-B type”, connected to the power adapter.

Seaker front side is shown.

The power plug connects as shown. Input cable from REM “speaker” jack shown above.

Press the + button until beeping is heard. The green battery light will illuminate when charging.
The volume should be reset to maximum Turn on the speaker by sliding the white
every time the speaker is turned on, switch to the middle position. The Bluetooth
as shown above. position is not used.
8
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Calibrating the Probe Tube

For reasons of infection control and reliability of results, MedRx recommends that a new probe tube be
used with each patient. To ensure accurate measurements, it is necessary to calibrate the probe
tube each time it is replaced.

1. Place a new probe tube on the
probe microphone port as
shown.

2. Place the probe tube between
the calibration nibs as shown.
Be sure that the opening of
the probe tube is centered on
the opening of the reference
microphone.

In the Avant REMsp software, do one of the following:

e Click the e Click Tools.
Probe - e Click —
Tube '\' e Calibrate etH:lp
Calibration i Probe Tube. Delete &l
Icon. |

Reset Data
Wideo Preview Shift-Enker

Probe Monitor

Calibr ate Probe Tube
| | X

Position probe microphone between

[ Probe Calibration
19 and 39 inches from the BEGLECENLES

loudspeaker and click Start. The Microphone: |Probe El
signal must be at least 70 dB to A T
Comp|ete a Va“d Ca“bra‘“on_ |f the - Place probe tube on tap of the reference microphone.

- Start calibration.

screen prompt indicates the signal is

too low, increase the volume on the

loudspeaker or move the probe ’—| S—— — M
. Star 5

microphone assembly closer and b

restart the calibration.

- Adjust the volume so that the Ref. Level is above 70dB

Valid calibrations have the same
View Help Close

approximate shape as shown here. If

the measured calibration curve differs
greatly in shape or amplitude from the
target curve, replace the probe tube
and re-calibrate. If this does not
correct the problem, contact MedRx
technical support at (888) 392-1234.

The calibration date is available under the Function > Calibrate > Calibration Information tabs. Return
Probe Microphones to MedRx for annual re-calibration
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Positioning the Speakers

Proper positioning of the
loudspeakers relative to
the patient’s hearing
aids is critical for making
accurate and repeatable
measurements. Seat the
patient so their ear is
between 19 and 39
inches from the
loudspeaker.

19 ” _ 39 ”
(48 -100 cm)

Make sure the grill of the loudspeaker is level with and directly in front of the patient’s head.

When using Live Speech inputs, position the patient so the mouth of the person speaking is in the same
position as the loudspeaker shown here.

Live Speech Mapping

Step-by-Step Guide to Live Speech Mapping

Ensure the Audiogram is Entered
Before making Live Speech Mapping measurements, the patient’s pure tone audiogram must be available
to the software. This can occur several ways:
1. The audiogram was automatically entered by MedRx AVANT, AVANT Audiometer or AVANT A’D
software when testing. Then saving the NOAH session.
2. The audiogram was manually entered into the NOAHaud 3 software and saved.
3. The audiogram was entered using another manufacturer’s audiogram module.

If none of these have occurred, you may manually enter the audiometric data into the AVANT REMsp
software as follows:

ez e e e e ————
i} - ENE v S =
-
Y s —_——— ’ '
S -
N -
-
et
~ et -
»
o
-

I
!
x

1. Launch the audiometric module by clicking
on the Audio button on the right side of the
AVANT REMsp main window.

Using your mouse, select the test ear.
Select the test type Air.

Enter thresholds by clicking the intersection
points with the mouse. (You may also enter
the audiogram by selecting the audio tab in
either the LSM or HLS/MHA screens).
Repeat for UCL (Bone and MCL optional).
Repeat steps 3-5 for the other ear.

PN

2
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After the audiogram is entered, click the Back button to return to the AVANT REMsp Main screen.

£
s [y

Q)} 2. In the next Window. Click LSM again.

1. From the AVANT REMsp Main screen, click LSM.

Linre
Speech

[lapping [

Speech Mapping with Live Voice Inputs

“**  The screenshot on the left shows the
Live Speech Mapping (LSM) window.
The system was designed to capture
= and display the human voice in the

(S ear canal, so we recommend using

o 4 « = the microphone input and the peaks

= g = .+ measurement.

@ _ ol — Using the microphone allows

i / N — measurement of both the

/A oo pmimmii st
e DL @“@‘ e patient’s significant others.

Fequocy (He) | Frecusny [Hz)

To improve repeatability of

x & measurements, it is recommended

~Z.% that the speaker read a standard
passage such as the “Rainbow
Passage” which is provided on pg. 24.
NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also possible
to underlay DSL i/0 or NAL-NL2 targets on this screen. Click Options in the text menu bar on the top of
the screen to select and configure these underlays to meet the needs of your practice.

Speech Mapping with Recorded Inputs

== iy

o e o For those who prefer a standard,
SN . o .
&8 [; repeatable stimulus for Speech

N [ 1 © v 3 pe
bt — SN v |

. Mapping, the software provides
several digital audio files.These are
S « accessed by clicking the File button
= on the right and then selecting the
. w» desired track from the pull-down
. - menu in the audio player.

/| 24 Once the desired track is selected,
3 S~ & @ click the Start button to begin
oo | , e measuring. When enough data is
s ik collected, click the Stop button to
14 stop the recording and
== s % measurement.

I
!

PSS <
D e T

It is also possible to use an audio CD, such as the patient’s favorite music to perform Speech Mapping.
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Simply click the CD button and then select a track as above. Use the sound level meter on screen to

check the proper level. Adjust the output of the speaker to desired level using the sound level meter.
(Remember conversational speech is 65 dB at 1 meter).

NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also possible
to underlay DSL i/0 or NAL-NL?2 targets on this screen. Click Options in the text menu bar on the top of
the screen to select and configure these underlays to meet the needs of your practice.

The screen shot below provides an overview of all the tools and controls on the Live Speech Mapping

screen. For more information on these features, please consult the Interactive Help system by pressing
the F1 key or clicking the Help icon.

. Legend
0. Target area — can be any of the following:
e MedRx Modified Speech Spectrum

1. Reference Microphone Level 5. Open Fit Function
2. Ear selection 6. Reset Button
3. Measurement type 7. Test Interrupter
a. Peaks 8. Discard, Help and Back buttons
b. LTAS 9
1

4. Input Selector

e DSLilo
e NAL-NL2
W AvantREM-SP - Live Speech Mapping 1 18] x|
File Function Ear Audio Stimulus Options... Tools Help
[ oo e @ [ - v — [ 70
Audio h %7 | | Speech %V Q€ | 2 i . . - -
‘ e I | ‘ i W 45 65 85

65% |
$ ¥
i 2 LeftEar | RightEar

SPL (dB) SPL (dB)

120 120

| L e |

— = ‘ ; @ Peaks Les ||

[ / i 110 ,\/ ‘ - ‘ |

| ! 4 | | 0 | / m
100 f 100 | ‘ @’ﬁj‘ ﬁmﬁ
0 | ‘ ‘
* \

{ L

110

90

G

80 [ 80

70 70

60

50 h i 50
w / |

il

> 125 250 500 750 1k

40

S
gty | -

' | | o —] —

% 125 250 500 750 1k 1.5k 2k 3k 4k Bk 8k

Frequency (Hz) - Frequency (Hz]
5 45|
|| m— At Conduction, Al=d7 %, PTAC28 | -
by [11. Speech In Quiet - Male =l :
— AT CONG | Al=41%, PTA33 Time: » n ]
s UnGomfortable level Drm: [ W o« o o x -
; Discard Help Back
i (@22 e dh

Running Speech Mapping "On-Top” within NOAH

It is well established that verifying the output of hearing instruments in the patient’s ear will improve the
accuracy of the fitting. In the past, it has been difficult to verify these fittings since many real ear systems
have been disconnected from the fitting system. The AVANT REMsp system is tightly integrated with
NOAH, the industry standard for audiometric and fitting data storage and retrieval. The “on-top” mode of

12
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the REMsp software allows you to effortlessly alternate between measurement and fitting adjustments.

Begin by opening the Avant REMsp

software from the NOAH measurement
module selection screen.

Fitting  Measurement I Other ]

[ | h{\V_/\Na];J m/é\an From the Avant REMsp main screen, click
NOA&Haud 3 AveriAz AveniREM the NOAH LSM button. The REMSp

window will reduce in size and “float” on

LAVANT LAVANT AVANT top of the NOAH screen.

[MedRx, Inc. HIT| MedRx, Inc. REM+| MedRx, Inc
AvartHIT AvantREM Plus Avart 1
+ AvantREM-SP
AVANT| |AVANT File Function Help

[MedRx, Inc. AUD| MedRx, Inc. REM-SP)
AvartAUD AvantREM-SP

Licensed to: - MedRx, Inc. - SALES - SALES LICENSE, FOR INTERNAL
L
?% NI RN & Open the fitting module from the NOAH

Module Selection Screen.

Client Infoimalion
8 E5 Module Selection

Fiting | Measurement | Tther |

Use the text menus and green and red
buttons in the floating LSM window to
make Speech Mapping measurements.
Make necessary changes to the

4 instrument based on these

3 \//'*f measurements. To make adjustments to

i giRasar the hearing instrument, click on the fitting
—— module window and modify the settings

according to the manufacturer’s
3 instructions, being sure to activate, apply
R or save the settings to the instrument.

o—o
sk

ooooooooo

e e e Repeat this measure/adjust/measure
cycle until the fitting is optimized.

Completing the On-Top Mode Process

Close the REM module by clicking the X button or go up to the File menu and down to
Exit. Save the NOAH session when prompted.

Note: It is also possible to run the REM module in “disconnected” mode. In disconnected mode, the
closing of the module is different. Check the advanced options, read “Fitting with NOAH" topic in the
integrated Help System to learn more about the disconnected mode.
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MedRx Live Speech Mapping Protocol

Unlike other products, the AVANT REMsp system places full control over the measurement environment
firmly in the hands of the hearing care professional. The system is powerful, yet extremely flexible,
allowing each provider to use Live Speech Mapping in a way that compliments their practice style rather

than compromising it.

In order to get you “up and running” with the AVANT REMsp system, MedRx has developed the following
protocol. This simple procedure has been found to be effective with both audiologists and hearing

instrument specialists. After mastering the basic operation of the system utilized in this protocol, you are
encouraged to further expand your use of Live Speech Mapping in your practice. Feature-specific help is
available by simply pressing the F1 key or clicking on the Help icon or text menu.

1. Complete a careful otoscopic examination as instructed by
the manufacturer of your otoscope.
a. For MedRx Video Otoscopes, refer to the Help
system within the software by pressing the F1 key or
clicking the Help icon or text menu.

2. Basic Diagnostics.
a. Using your audiometer and NOAH, measure and
record the following values:
b. Pure Tone Air and Bone conduction thresholds
c. Narrow Band Noise or Pure Tone UCL at 500, 2000
and 3000 Hz
d. Other tests if needed in your practice or jurisdiction

3. Position patient as described earlier in this manual.

4. Calibrate Probe Tube as described above.
5. Measure and place the probe tube in the ear canal. (Use
chart to the right).
6. Complete a Live Speech Mapping measurement UNAIDED.
a. Microphone input
b. Peak Measures
c. 1/3 Octave resolution

7. Carefully place the hearing instrument in the ear without
disturbing the probe tube.

8. Complete a Live Speech Mapping measurement AIDED.

9. Using the On Top Mode, make any adjustments needed to
the hearing instrument so that:

a. The LSM curve for Quiet Speech (50 dB) is at the
bottom of the white modified speech spectrum
(canoe).

b. The LSM curve for Conversational Speech (65 dB)
should be at the top of the white modified speech
spectrum.

c. The LSM curve for loud sounds (85 dB) (very loud
speech, clapping hands, etc.) is approximately 10 dB
below the UCL curve.

ASP-I-MASPT-5 MedRx AVANT REM SP Training Manual
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Probe Tube Insertion Guide
for Live Speech Mapping
and Conventional REM

(re: Pomford, 1 & Sinclair, 5. Real-Ear Measurement:
Basic Terminology and Procedures. Audiology OnLine.com)

L
Adult Male (30mm)

< | ]
Adult Female (28mm)

< | 1
Child (20-25mm)

1, Perform Otoscopic Examination

2. Align end of Probe Tube with the
left end of the appropriate guide

3, Align tube marker with the red
marker above

4, Place Probe Tube in ear canal
5. Confirm placement with Otoscope
6. Perform Live Speech Mapping & REM

14



Real Ear Measurements

In addition to Live Speech Mapping, the Avant REMsp supports all conventional Real Ear Measurements

(REM). All these tests are accessed from the main REM screen.

To begin, click the ?”%9
rew 3

In general, REM tasks are performed as follows:

AvantREM-SP - Aided Response - Cliont: MoRx, MedRx (*)

Fle Function Ear Audo Target Stimuus Options... Tools Heb

Audo || Fitnofix  REUR | REUG | REIG | | REAR  REAG || REOR | REOG OF || RECD | 2 (in

s [ 9
? Lot Exr Right Ear

@ OpenRt |+

* @e ©
- E
40 1 & Setup NALNLY
- Insert/Tip, BTE, Binaural.
4 ‘WDRC5¢ch.

) | | (| e} s Lo : |
= 15 20 S0 780 1k 1% X % 4k &k B = 1% 20

L
o 2
3

Frequency [ Hz] Frequency (Hz) |

X -

Discard Heb Back

4. Click Start. The test will stop itself after sufficient data has been
collected and averaged.

5. If you wish to delete a curve, simply select it with your mouse
and then click the Discard icon or press the Delete key.

6. When all measurements are complete, click the Back arrow to
return to the AVANT REMsp Main Screen.

To activate specific REM tests, click the buttons as follows:

button on the right of the Avant REMsp main screen.

Select the REM
test you wish to
perform from
the top row of
buttons.

Select the test
ear.

Select the test
stimulus.

Audio measured and entered into NOAH.

Opens the audiometry data entry screen. Use this if audiometry has not been previously

Allows the selection of fitting rules to generate insertion gain targets. The following rules

to a stimulus. Reported as dB SPL of output.

FittingR= | | are supported: ¥ Gain, POGO |, POGO I, Berger, 1/3 Gain, NAL-RP, FIG6, DSL, NAL-
NL1, NAL-NL2.
REUR Real Ear Unaided Response - Measures the additive effect of the ear canal’s resonance

the REUG screen.

Real Ear Unaided Gain - Measures the additive effect of the ear canal’s resonance to a
REUG stimulus. Reported as dB SPL of gain. If a real ear unaided response (REUR) curve has
been measured, the corresponding real ear unaided gain curve is automatically plotted to

selected for the client.

The difference between the REUG and the REAG is called the Real Ear Insertion Gain
REIG (REIG). This Insertion Gain information is used to compare to the target gain curve

ASP-I-MASPT-5 MedRx AVANT REM SP Training Manual
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The Real Ear Aided Response (REAR) is the sound pressure level in the ear canal
measured with the probe microphone close to the eardrum and the operating hearing
REAR instrument inserted in the ear and turned on. ANSI defines REAR as the SPL, as a
function of frequency, at a specified measurement point in the ear canal for a specified
sound field, with the hearing aid in place and turned on.

The REAG is simply the REAR expressed as gain rather than SPL. Selecting REAG

REAG allows you to see the gain at each frequency for each of the REAR curves measured.

REOR measures the effect on the natural external ear effects resulting from inserting an
REDR ear mold or a hearing instrument, before it is turned on, into the ear canal. The REOR is
also referred to as Insertion Loss. REOR is also useful for validating the effectiveness of
venting or canal length changes to the mold.

The Real Ear Occluded Gain (REOQ) is the difference in decibels, as a function of
frequency, between SPL in the ear canal and SPL at the reference microphone at the
REOG entrance of the ear canal with the hearing aid in the ear and turned off. For each REOR
measurement curve, the corresponding REOG curve is calculated and automatically
plotted to the REOG screen. The REOG function is useful in determining the acoustic seal
of a hearing aid, relative to a sound field outside the ear.

Some clients report they seem like they are “speaking in a barrel” or “feel blocked up”.
0/ These are signs of a build up of self generated low frequency energy in the ear canal. This
excessive occlusion can be measured objectively in the Occlusion Effect task.

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by
RECD coupler measurements and is useful when fitting children or “difficult” to fit patients. See
the section on RECD later in this manual for more detail.

Sample REM Screens

The Avant REMsp system supports all current ANSI and IEC Real Ear Measurements. The
screenshots below were made using the software defaults. These defaults set the test
parameters for each test according to these standards, however the test environment is fully
configurable to meet individual professional’s needs.
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Additional Tests & Features

Real Ear to Coupler Difference (RECD)

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by coupler
measurements and is useful when fitting children or “difficult” to fit patients. The RECD values are used
as a correction to coupler measures for that client’s hearing instruments. By performing all subsequent
measures in the coupler and applying the RECD corrections to the coupler measures, the “real ear”
factors are incorporated into the results. The resulting simulated measurements provide information to
select and make adjustments to the hearing instrument and verify adjustments in the hearing instrument
test box rather than in the uncooperative client’s ear. This is particularly important in the case of children,
whose small volume ear canals enhance high frequency amplification more so than in average adults.
This is an essential consideration in determining the maximum output of the hearing instrument.

If RECD data is present, the software will display an option to choose between Ear or Coupler
measurement on all Real Ear screens where measurements in a coupler are appropriate.

There are two ways to measure the REAR response: using an insert headphone or a hearing instrument.

If a hearing instrument is used, its volume control setting and other parameters should remain the same
for both REAR and coupler measurements. It is also recommended to set the volume control to
moderate, and turn the compression and noise reduction circuits off.

How to perform the RECD task

First, perform the Ear Response task. This can be measured with a hearing instrument or an insert
earphone.

Ear Response with a hearing instrument
‘ e Adjust volume of the hearing instrument to comfortable listening level.
It is also recommended to turn the compression and noise reduction
circuits off.

e Position the client less than one meter from the speaker and facing
the speaker.

e Place the hearing instrument and the probe microphone tube as for
all REM measurements.

e Select START to open the measurement type selection screen.

e Choose the Ear Response with a Hearing Aid option.
e Select OK to begin the test and wait until it concludes.
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Ear Response with an insert headset

e Place the probe microphone tube as for all REM measurements but
use the insert headset instead of a hearing instrument. Connect the
insert headset into the speaker jack on the REMSp.

e Select START to open the measurement type selection screen.

e Choose the Ear Response with an Insert Headset option.

e Select OK to begin the test and wait until it concludes.

Coupler response

When the Ear Response is complete, you are prompted to perform a coupler response.

e Attach the hearing instrument or the insert headphone (must be the
same as in the Ear Response test) to the appropriate coupler and
place the probe tube inside the coupler.

e If a hearing instrument is used, be sure to perform this measurement
at the same volume control setting as the first measurement.

e Select START to open the measurement type selection screen.

e Choose the Coupler Response option or Use Stored to skip the
measurement (see note below.)

e Select OK and wait until the test completes.

e The calculated RECD curve is automatically displayed on the screen
and is stored in memory for correction of subsequent coupler
measurements made from the RECD function.

Note: If the REAR and the coupler response were measured with the insert headphone, the program
saves the coupler response curve for later use. In this case to obtain another RECD, only Ear Response
with insert headphone measurement is necessary. This is possible because the coupler response does
not change provided that neither the coupler nor the insert earphone has changed.

Note: After measuring RECD, it is possible to perform Live Speech Mapping in the coupler as well. Look
for the “Measuring in” option on the LSM screen.
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Measuring Acoustic Feedback

Feedback (whistling, howling) is one of the most common complaints of hearing instrument users. Even
though many modern hearing instruments have sophisticated feedback management systems, knowing
exactly where the feedback is occurring can greatly reduce the time required to resolve the problem. The
AVANT REMsp system does an excellent job measuring and displaying acoustic feedback.
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Place the calibrated probe tube in the ear canal as
instructed previously.

Place the hearing instrument in the ear without
disturbing the probe tube.

Begin a Live Speech Mapping session as instructed
previously.

When feedback is present, click the Start button.
Acoustic feedback appears as a large spike in the LSM
response.

If a more specific frequency analysis of the feedback is
desired, change the resolution of the system to 1/24
octave by clicking the Options menu item and
changing the Analyzer selection using the pull-down
menu. This image shows the same feedback as above
at 1/24 octave.

Using this information, make any needed adjustments
to the hearing instrument to reduce or remove the
feedback.
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Hearing Loss Simulator

The Hearing Loss Simulator demonstrates the effect of the client’s hearing loss for the significant
third party. The program attenuates an input signal to simulate the audiogram.The third party
listens to the free field speakers. The third party can hear how their own voice is distorted by the
hearing loss when the Record input option is used.

The Hearing Loss Simulator requires the client’'s Audiogram data. This data can be manually entered in
the Audio screen of this or any other task.

How to perform the Hearing Loss Simulator task

AvantREM-SP - Hearing Loss Simulator - Client: MeRx, MedRx (*) l

Select the Hearing Loss

Simulator tab on the

toolbar.

Enter the Audiogram

values manually if the data

is not automatically

imported to this screen.

! 3. Select the input signal

e i - ey type: Mic, File or Record.
o) J = @ Select the track and the

B Play button on the control

i 1 & @ panel. See below for
8! V/N ; @ instructions on how to use
SN i the Record option.
B i The HLS output is directed
ot At e (== - ; to the free field
ST . = loudspeakers.

4. Select Normal to play the input signal as a person with normal hearing would perceive it. Select
Simulated to turn on the simulation of the client's hearing loss. Toggle between these selections as
necessary.

5. The Reset option restores the audiogram to the original state. Use this option if you have modified
the audiogram while in the simulate mode but want to undo the changes. The changes to the
Audiogram that are made on the HLS screen are temporary and will not affect the client's original
audiometry record.

6. A volume control adjustment bar allows for manual adjustment of the output level of the freefield
speakers.

7. To stop the playback, select the Stop button on the player.

Note: It is recommended you use a variety of tracks from the list to demonstrate the hearing loss.
Record Input Option
This option allows recording and playing back of the voice of the third party.

Note: The LSM option appears on the bottom half of the display. This is so the unaided and aided results
can be displayed simultaneously for the patient and significant third party.
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Master Hearing Aid

Master Hearing Aid is an alternative to using a stock hearing aid to demonstrate the benefits of
amplification to an inexperienced user. The system applies the fitting rules by default to the patient's
audiogram and simulates a hearing aid. The patient listens to this signal through the headphones.
Options for editing the gain applied to the audiogram are provided.

About the Master Hearing Aid Display

The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and Frequency in Hz
on the horizontal axis. The plot on the graph represents the gain applied to the patient’s Audiogram. The
NAL-RP is applied by default. A new rule can be selected from the list on the right side of the display. A
volume adjustment bar allows for manual adjustment of the output level. The control panel on the right of
the display provides options for input signal source and the task icons for Normal and Simulate.

The Master Hearing Aid applies gain separately for each ear. If audiogram values are entered for the left
and right ear, the selected fitting rules will be applied to each ear separately. Different rules may be
entered for different ears (i.e. NAL-RP for left ear and BERGER for right ear). If an audiogram is entered
only for one ear, the gain will not be adjusted for the opposite ear and the sound for that ear will be
normal.

If Binaural mode is selected, the sound will be heard from both channels (left and right). If Monaural
mode is selected, the sound will be heard only from the channel corresponding to the active ear when the
channel for the opposite ear will be muted.

Input signal

Live voice (microphone) allows you to use the right probe mic for live speech input to the
headphones. The clinician or significant third party can speak into the microphone for this activity. Note:
there is a processing delay between the input and playback. Make sure that the client cannot hear the
voice directly but only through the headset. If this is not possible, use the Recorder (describer below) to
simulate speech input.

File allows the user to play sound files. The program supports MP3 and WAV files and comes with a
preset MedRx Sounds Sensations set of files. After the option is activated, use the player panel to control
the playback.

CD allows the user to play music CDs. After the option is activated, use the player panel to control the
playback.

Record input mode allows the clinician or third party to record a sample of their speech which can then
be replayed for repeat comparisons under different amplification conditions for the patient. Refer to the
interactive Help system by pressing F1 or clicking the Help icon to learn more about the recorder.
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How to use the Master Hearing Aid:

AvantREM 5P - Master Hearing Aid - Client; MeRx, MedRx (*) < &) 1

Select the Master Hearing Aid

(MHA) icon from the main screen.

2. Enter the Audiogram values
manually if the data is not
automatically imported to this
screen.

3. Select the input signal type: File,
CD, Mic, or Record.

4. Select Monaural or Binaural

5. Select the Normal icon, which will send the input signal through to the inserts without modification.
The patient is listening to the signal without any amplification benefit. Select the Simulate icon to
modify the input signal according to the selected rule. This selection allows the patient to hear the
benefits of amplification. Toggle between these two selections as necessary.

6. If the simulated frequency response needs to be adjusted, based on feedback from the patient,
manually edit the response by clicking on the gain curve at the desired frequency and new gain
level. The gain curve of the selected test ear on the control panel can be edited. To edit the other
ear, click the appropriate test ear icon on the control panel first.

T o] | IOSR T E S Hint: Use _the track return icon on the player control panel to replay one
EQ) W o« » track continuously.

The Reset option restores the rule to the original state. Use this option if
you have modified the rule but want to undo the changes.

Printing
Printing within the Avant REMsp software is very simple.

7 AvantREMsp - Audiograms From the File menu, click one of the following options:

M Function Ear Audio  Stimulus . .
Print Setup — selects the printer you want the report to be

e & L sent to. Avant REMsp prints to any installed Windows
s A printer.

Open |55

Save Page Setup — Allows you to set margin sizes and the

cles SasSn Dot default text header for your reports.
Export Print Preview — Shows you what your report will look like

Print Setup... before you print it.

Page Setup...
Print Preview

Go Back I g CtrlBack —

Exit Alt-F4

Print — Sends the report to the printer.
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Rainbow Passage

When the sunlight strikes raindrops in the air,
they act like a prism and form a rainbow. The
rainbow is a division of white light into many
beautiful colors. These take the shape of a long
round arch, with its path high above and its two
ends apparently beyond the horizon. There is,
according to legend, a boiling pot of gold at one
end. People look, but no one ever finds it. When
a man looks for something beyond his reach, his
friends say he is looking for the pot of gold at the

end of the rainbow.
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Limited Warranty

MedRx, Inc warrants this product to be free from defects in material and
workmanship for one year from the time of purchase. If this system fails to perform
as specified during this period, the purchaser is responsible for calling MedRx at
(888) 392-1234 or (727) 584-9600. The company's representative will advise the
owner to either return specific components or the entire system to:

MedRX, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA

MedRx will repair or replace any defective devices, fully test the system and/or
components and ship the system promptly back to the owner. There is no cost for the
repair or return shipping, provided the system is one year old or less and has not
been misused, abused or damaged. Such damage includes, but is not limited to,
dropping, exposure to excessive heat greater than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and
exclusive remedy of the purchaser. MedRx shall not be liable for any consequential
or incidental damages or for breach of any express or implied warranty. Except to the
extent of applicable law, any implied warranty, merchantability or fitness of this
product is limited to the duration of this warranty.

MedRx will, at its discretion, service and repair out of warranty products at the
purchaser's request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on this
product which is not pre-approved by MedRx, Inc. Approved software includes
NOAH™ and HIMSA approved hearing aid manufacturer programming modules for
fitting hearing aids.

MedRX, Inc is not responsible for problems resulting from installation of unapproved
software or hardware. In the event of unapproved software or hardware installed on
the system causing a conflict, MedRx will service the product for a fee to be
determined at the time of service.

Any extension of this warranty past the initial one-year warranty is subject to the
following (where applicable).

1. A $300 deductible per repair.

2. Extended warranty does not include cables, connectors or peripherals.

3. Extended warranty of the Video Otoscope covers optics only.
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